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Chapter 1. Getting Started 

Installation 

Backing up your files 

If you already have Easy-PC installed, please remember to back up all your Libraries, Technology 

files and any other data files before proceeding with the installation of the new version. The installer 

should not overwrite any of your own named files, but it can re-install new copies of our standard 

data files so if you have changed any of those files it is important to back them up first. If you are 

uncertain, check the time/date stamp on the file but in any case, make a back-up. 

Of course, backing up your data is important not only for the upgrade but also at regular intervals 

during design. 

Installation from a download link 

A download link for the installation of Easy-PC would have been provided to you by email. Click on 

the link to download the executable named EasyPC.exe. This is the whole installation set and should 

be saved and backed up for future use. Any subsequent patches can be installed on top of this 

‘base’ setup once installed. 

Using Windows Explorer, find the executable in your Downloads folder and double-click it. You’ll 

need to type (or copy/paste) the password provided to unpack this file. Once the unpack password 

has been successful, you will be allowed to continue with the installation. You will also need to have 

your customer ID number that will be in the download link and your 16-digit installation code to 

fully install the product. See below for more details. 

The installation is the same for new and existing users alike. Existing users with versions prior to this 

latest version can install the new software over an existing installation without deleting the old one 

first. 

Installation From CD 

CDs are no longer supplied; a download link would have been supplied to you by email. 

Installing over existing Easy-PC software 

You cannot install Easy-PC into any folder that already has any contents. You must install into a new 

empty folder. 

A new installation of Easy-PC 28 will present you with the default folder during installation. We 

recommend that you do not change this. If you do, please select an empty or non-existant folder to 

use. 

If you wish to install and use the new version without removing the old one, you will need to install 

the new version into a different folder. The two versions will then operate independently and either 

can be un-installed without preventing the other from running. 

If you have customised any Easy-PC 27 menus, toolsbar or user defined settings in your old version, 

then create a Configuration file first that can then be read into V28 to retain these settings, see below. 

They will NOT be transported from V27 to V28 automatically. 
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Saving Previous Version Settings 

Version 28 now has its own registry settings. This means that if you have customised any toolbars or 

Preferences etc, these will not be passed forward into the new version. Going forward with the next 

version, they will be carried forward. 

However, if you use Configuration Files and the Save option (from the Start menu, Number One 

Systems folder) you can save your setting to Load into the new version. 

 

New Installer 

Easy-PC 28 is provided with a new install program. It provides the same functionality but looks 

slightly different. 

 

You will need enter each tab to provide the information required, such as agreeing to the License 

Agreement, your Registration details and product install code. The two other tabs inform you where 

the product will be installed and changing file extensions. 

Uninstalling Existing Easy-PC Software 

Uninstalling will still remove shared registry entries, so it is recommended that a configuration file be 

saved first using the Configuration Files option from the Help menu and Support option. This will 

provide a restore point for any settings which may be lost. 
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Data Files Location 

There is a step in the Setup installation wizard that asks you where you want to place data files (for 

example, Libraries, Technology files, etc). The default is always to use the common documents 

folder, C:\Users\Public\Documents\Easy-PC on Windows 10 or 11 if you are installing for All Users, 

or into your own Documents folder if installing for current user only. 

Running Easy-PC 28.0 

Once installed, an Easy-PC shortcut icon will appear on your desktop. 

This is also available on the Start panel in the Number One Systems 

folder. 

To start the program, double-click on the Easy-PC icon on your 

desktop.  
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Chapter 2. New Features in Easy-PC V28 

 

Menu and Toolbar Rationalisation 

Changes have been made to the interface to tidy up and rationalise some of the menus and toolbars. 

The release of version 28 has also been an opportunity to add some essential functions to toolbars. 

New Utilities Menu 

A new Utilities menu has been added to PCB Design, PCB Symbol Design, PCB Technology, 

Schematic Design, Schematic Symbol Design and Panel Design contexts. This menu contains 

commands that have been moved from the Tools menu in order to rationalise functionality into more 

logical groups and to reduce the number of options on the Tools menu. 

 

Rationalised Toolbars 

The File, View, and Settings Toolbars have been modified to only include commonly used 

commands. This rationalisation will be more in-keeping with the design process. If you wish to add 

your own toolbar icons to these or to your own toolbars, use the Toolbars option from the Customise 

dialog (available on the Settings menu). 

 

New Align Toolbar 

A new Align toolbar has been added which contains all of the Align commands. 
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Tools Toolbar Renamed to Utilities 

The Tools toolbar has been renamed to Utilities to better reflect its usage. 

 

Folders and Preference Toolbar Shortcuts added to toolbar 

Shortcut icons have been added to the Utilties Toolbar to include the Preferences and Setup 

Folders commands. 

 

This will provide you quick access to these commonly used features. 

.EPL Files Imported to Create Full Library Content 

When doing a library import (drag and drop) using an EPL file, you can now import Schematic 

Symbols, PCB Symbols and Components at the same time (provided the epl file contains them, some 

don’t). 

EPL files are created and downloaded from third party component content creators, such as 

Samacsys, SnapMagic, Ultra Librarian or PCB Libraries. This content is ready to use once stored in 

the Easy-PC library system. EPL files provide an alternative if you are not using one of the integrated 

systems using the Library Loader from Samacsys or the Component Search Engine from SnapMagic. 

When the file is dropped, you will be prompted to select a technology file for your Schematic and 

PCB Symbols (it prompts once for each type). Once selected, the dialog will then populate with the 

library items that are included in the file, ready to be imported.  

You can select which library should be used for each library type on this dialog. 
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Set Symbol Origin at Centre of Pads 

A new context menu command, Set Symbol Origin at Centre of Pads, has been added. This is 

availabel when editing PCB Symbols and Schematic Symbols.  

When editing a symbol, with nothing selected, right click and select Set Symbol Origin at Centre of 

Pads. On selection, a centre point between all the pads in the symbol will be calculated and the 

Symbol’s origin will be reset to this calculated point. 

 

The result resets the symbol origin to the centre of the pad area: 

 

Save Copy As for Components 

The Save Copy As command has been added to the Component Editor. 

When editing a Component, this command will prompt you with the standard file Save dialog, from 

where you specify the path where you want the copy of the current file to be saved. The file will be 

saved as a self-contained .cmp file that can be imported into another library. 

Import option added to Schematic Symbol Editor 

The Import option has been added to the File menu when in the Schematic Symbol Editor. This 

enables you to import DXF files to create items such as drawing borders. 
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Styles Tool Changes in the Library Manager 

In the Library Manager and Styles Tool, the Manage Styles dialogs now have an extra column in 

the grid (Tech) indicating if the selected style exists in the Technology file or not. This helps you 

choose the merge; you may have a preference for name styles used in the Technology over local 

names, enabling you to keep the style consistent with the design. 

The Tech column shows N for not from the Technology file or Y or in the Technology file. 

 

Close using Cross on Window Tabs 

Window tabs now have a Close cross. The active window will show the cross, whilst other windows 

will only show the cross when the mouse is hovered over them. 

 

Switch Variants on the Status Bar 

With a design containing Variants, the Status Bar will now show you which variant is currently 

active.  

If you double click on the Variant Name in the status bar, it will open up the Change Variants 

dialog which allows you to select a new current variant. 
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Connection Guides Colour Option Added in Schematics 

The Schematic Colours page now has a visibility and colour option for Connection Guides. 

Connection Guides are available when you have used the Reverse Engineer option to create a 

Schematic design from the PCB when the Schematic doesn’t exist. 

 

Text – Own Colour Selection 

You can now set a custom colour on free text.  

Free Text is coloured using the Colours dialog, but this change enables you to override that colour 

using the Text Properties dialog. 

By selecting the Use Own Colour check box, you can then choose a colour for that selected text item 

or items.With this selected, you can use the drop down colours box to specify the text colour. 
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Forward Design Changes – Option to Save Schematic 

When running the Forward Design Changes option from Schematic to PCB, you will be prompted 

with the option to save any current changes to the Schematic design before continuing with the 

process. 

 

Can now add new Value Names in Value Properties Dialog 

From within a Symbol (using the Schematic or PCB Symbol Editor) and the Values Properties 

dialog of a selected value, you can now directly add additional Values. Previously, this was only 

possible using the Design Technology dialog and Values page; this option is still available. 

There are two new buttons on the Values Properties page, + and / 
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Clicking + will open the Add Value Name dialog where you can create a new Value name.  

 

Clicking / will open the Edit Value Name dialog where you can edit the selected Value. 

 

Flip Vertical and Flip Horizontal 

There are some changes to the Flip option:  

Flip is now Flip Horizontal in Select mode and Move, and is available on the context menus. 

This does exactly what the previous Flip option did. 

Flip has been renamed to Flip Segments on the Edit Track, Edit Connection and Edit 

Shape context menus. 

A new option, Flip Vertical, has been added to Select mode and Move on the context menus. 

This does Flip Horizontal followed by a rotation of 180 degrees. 

A new option, Mirror and Swap Layer has been added to PCB, see below. 

To summarise the changes to Flip: 

Flip Horizontal – this mirrors the item to the other side of the board (for a PCB). In a Schematic 

design, it will mirror the symbol in the X direction about the symbol origin, pin 1 in the example 

below, flipping the symbol from right to left. 

 

Flip Vertical – this mirrors the item to the other side of the board and applies a rotation (for a PCB). 

In a Schematic design, it will mirror the symbol in the Y direction about the symbol origin, pin 1 in 

the example below, flipping the symbol bottom to top. 
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Mirror and Swap Layer Command Added in PCB 

A new command, Mirror and Swap Layer, appears in context menu when in PCB with a layer item 

selected, such as Copper. This allows you to Flip the item position and Swap the layer of a selection 

of items assuming the design layer check is passed, meaning it can be swapped. This command is not 

available for a Schematic design. 

The starting item is selected: 

 

The command is executed and the resultant item is now Flipped in the X direction and mirrored to the 

the opposite layer: 

 

To show the shape before and after, superimposed together, the right shape is selected, and the 

resulant shape is show in red on the left: 

 

New Callout Pointer Shapes 

Two new shapes have been added to Callout pointers - Cross and Plus. These are added in addition to 

the existing shapes available. 
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An example of the Cross shape is shown below: 

 

Use the Callout Properties dialog to change the Pointer End type: 

 

Paste copied Shape as a Cutout 

You can now paste a copied shape as a Cutout. 

How to do this… 

As an example below, starting with the shape you wish to copy on the left side and the shape to which 

you wish to add the cutout on the right side of the illustration: 

 

Select and copy the shape that you require for the cutout, select the whole shape and press Ctrl-C to 

copy it: 
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From the Add menu, select Add Cutout and select any sub option (Shape, for example).  

Select the shape you wish to add the cutout to: 

 

Now paste (using Ctrl-V) and position the cutout shape. 

 

Cut Shape 

The Cut Shape option has been added to the Edit menu. This allows you to cut a shape into two or 

more individual closed shapes. 

When run, the ’cut’ line will create two (or more) overlapping shapes, where the centre line of each 

shape overlap. 

Start with the unselected shape: 
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Select Cut Shape from the Edit menu and select the shape(s) to change it to. Draw the ‘cut’ shape: 

 

The shape will split to create two or more overlapping shapes. The centre lines of the overlapping 

shapes are coincident. 

 

An alternative to having overlapping shapes is to right click with this option enabled, and to select  

Change Cut Width using option on context menu. 

 

Type the cut line width, this will effectively be the ‘gap’ between the edges of the two shapes once 

applied. 

 

Remove Highlight added to the context menu 

There is a new context menu command, Remove Highlight, that will unhighlight when any items are 

highlighted in the design. This is available when an item is highlighted and nothing else is selected. 

This option is also available for Net Highlights. This is particularly useful in conjunction with the 

Goto Bar. 
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Component Positions Reports name changes 

The Component Positions BOM and standard reports have been renamed to Pick and Place to 

reflect a more accurate description of their usage. 

Under BOM Composer Reports - Component Positions renamed to Pick and Place 

Under User Reports - Component Positions renamed to Pick and Place 

Under User Reports - Component Positions CSV renamed to Pick and Place CSV 

User Reports - Associated Parts List 

You can now add Associated Parts List to your user report.  

From within the Report Editor dialog, select Add List… and select Associated Parts.  

 

The following columns can be reported for associated parts: Part Name, Quantity and Description. 
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Rotate Around Centre 

A new context menu command, Rotate Around Centre, has been added to the Rotate section of the 

context menu when placing or when using select mode with an item selected.  

 

The command acts as a tick box, when enabled, rotation of the selected item will rotate around the 

centre point of the selection (rather than the origin). 

Drop Via Option Added to Add/Edit Track 

When adding or editing a track, you can now right click and select Drop Via from the context 

menu. 

 

Using this feature will add a via at the location of your cursor, and continue with the track on the 

same layer, no layer change is made. This is a useful option if you wish to stitch in vias for shielding 

purposes or for enhancing power distribution paths. 

Edit Track – Backspace moves the cursor to the end segment 

If backspace pressed it will still go back to the previous segment corner (as before), but now the 

cursor will move to the start of the previous segment. 
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While editing, pressing the backspace key removes the track segments and moves the cursor back to 

the last segment corner: 

 

Change Text to Shapes 

You can now convert True Type text into shapes, (Note, this doesn’t work with the system ‘stick’ 

font). You might do this if you wish to mill the text in copper if using a PCB prototyping machine for 

example. 

To do this, select a piece of text that uses a true type font. Right Click, and from the context menu, 

select Change Shape Type. A dialog will appear to request which shape type to use. When OK is 

pressed, the text will be converted into that type. 

 

A dialog asks you to confirm the shape type: 

 

The text is now individual shapes that can be edited or deleted when selected: 

 

Add Text Cutout 

There is a new Cutout option on the Add menu for Cutout Text. This allows you to create a cutout 

from any true type font text.  

End point of cursor after pressing Backspace 

Start point 
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To use this option, select a shape and go to the Add menu and Cutout Text. You could also start 

with an unselected shape and use Add Cutout Text, and then select the shape to apply it to. 

Select a target shape:  

 

This will prompt you with the Add Text dialog. You can specify the text you want to add and 

whether you want the final shape to be grouped together. Grouping it means you can move the text 

along with the shape if you wish to reposition it. 

 

Once confirmed using the OK button, select the position that you want the cutout text to be placed 

 

Once released, the shape now includes the text: 

 

After it is deselected, the shape and text look like this: 
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Copy / Paste multiple document shapes between design types 

You can now copy and paste multiple selected shapes between design types. For example, a 

Schematic shape defining your company drawing border can be copied and pasted into your PCB 

design (to create a PCB drawing border). The shape will be added using the Styles and Layers from 

Shape defaults under the Settings menu in the target design if copying to a PCB design. 

Add Diff Pair – Show Legal Via Positions 

Whilst adding the paired track segments you can use Show Legal Via Positions to display circles 

where the vias will land if you decide to change layer. It also shows smaller circles where the tracks 

will start on the next layer after adding the vias and the track transition pattern.  

 

This option is available to toggle on or off on the context menu when in Diff Pair mode: 

 

If this option is on and Online DRC is on, and the vias would not be legal due to obstacles on the 

other side, the circles will not be shown. 

Low Level Geometry Overhaul 

As information for you, and with no visible dialog or functional changes, the underlying geometry 

used within the Copper Pouring algorithm has been updated and improved. One of the main benefits 

to you is the stability when running this routine. You will also see a greater accuracy of pouring into 

areas where you might have expected it to pour but where it hadn’t previously. This is the main area 

where the new code impacts design, but it is also used in other lesser visible areas of the product, such 

as DRC. 

Via patern landing site 

Track exit position 
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Design Rules Checking (DRC) 

DRC Dialog Reorganised 

The DRC dialog has been reworked to simplify and organise the existing controls. 

 

Remove Errors Warning 

In the DRC dialog, when removing existing errors (any of the three Delete Errors buttons), a 

warning will prompt you instead of the normal message box. This allows you to turn off this message. 

The message can be restored using the Preferences dialog and Warnings page. 
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Goto Bar 

Shortcut to DRC Option from Goto Bar 

In the Goto dockbar under Errors, there is a new context menu command, Design Rule Check. This 

provides you with quick access to the Design Rule Check dialog. 

 

Select All Items in Section Context Option for Errors 

In the Goto – Errors dockbar, there is a new context menu command Select All Items in Section. 

This command is available when a section (such as an error type or layer, not an individual error) is 

selected, for example the Error Type being checked. This command will select all the errors within 

this category (Error Types). 
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Via Oversize Displayed 

Via oversize (when defined) is now shown and coloured in the Solder Mask colour using the same 

colour as pads. This prevents issues such as the vias appearing bigger than their actual size when 

plotted. 

In previous versions, vias were shown like this, with no solder mask clearance displayed: 

 

Error Types 

This options 

becomes available 

No clearance shown 
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Vias will now be displayed showing the solder mask clearance: 

 

Layer Type Filters added for Testlands, Layer Exceptions and Star Points 

Options have been added to the Layer Type dialog within the Design Technology to enable you to 

filter the pads that appear on layers in a particular class meeting certain conditions.  

New conditional switches have been added for Testlands, Layer Exceptions and Star Points. 

 

These options work in conjunction with the pad filters (Surface Sym. Pads etc.).  

Testlands Only and Exceptions Only will only affect pads that would appear anyway due to the 

selections made with the pad ‘type’ switches. 

Vias is existing functionality. 

Star Points is the only switch which will force pads to display (or not) regardless of other switches. 

Drill Ident Setup Dialog – Generate from design and improvements 

The drill ident setup dialog has been improved in order to facilitate and manage your drill idents more 

efficiently. This is available under Output, Plotting and Printing, Options button, Setup Sizes and 

Symbols button under Drill Ident Drawing. 

A new Generate button has been added. When pressed, it will replace the current items in the grid 

and add all the drill sizes in the current design using the default drill ident values. If you subsequently 

add another pad or component that contains a drill size not already in the list, it will automatically be 

added as normal when the drill table is updated or when the plotting dialog is entered. 

Vias shown with solder mask clearance 
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Drill Ident Setup Dialog – Used column 

The drill ident setup dialog now shows you which drill idents are being using by the current design. 

In the Drill Itent Table on the dialog, there is a new column, Used. For each drill size defined in the 

grid, a Y will appear in the used column indicating that this drill size is used in the design. 

 

Drill Ident Drawing – Allow 0 size and/or no ident plots 

Plotting drill ident drawings can now handle 0 (zero) size and empty drill idents.  

A 0-size drill ident (meaning an ident symbol of size 0) is used to indicate that the symbol should not 

be plotted.  

An empty drill ident string is used to indicate that the drill ident text should not be plotted.  

These new settings, together or separately, allow you more control on what drill ident information 

will be plotted without the need for deleting idents (grid rows) on the Drill Ident Setup dialog.  

Auto Generated Gerber Drill Plot Removed 

In previous versions, auto generated plots in the plotting dialog used to include a Gerber Drill plot. 

This has led to confusion and is not generally required for manufacturing. This no longer occurs for 

auto generated plots in Version 28. However, if you already have this plot type, it can be removed 

from your plotting set by simply selecting it and using the Delete Plot option. 
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If you still require this plot, it can be generated manually using the Add Plot option. 

Plotting – Automatic Generation of All Plots option 

There is a new button on the Plotting and Printing dialog - Auto Gen…. This will generate a set of 

plots for every Electrical and Non-electrical layer in your design, plus drilling and Drill Ident layers. 

Electrical and Non-electrical plots are generated in Gerber format, with NC Drill files generated in 

Excellon format. The Drill Ident plot is generated in Gerber format also but can be reconfigured if 

required. 

 

When selected, a warning will prompt you to confirm the removal of all existing plots, if OK is 

pressed, new plots will be automatically generated. 
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Plot Preview – Shows Pads-Only Normal Vias and Testland Vias 

When previewing a Pads-Only plot in the plotting dialog, such as a Solder Mask plot, the Plot 

Preview now shows and/or hides normal vias and Testland vias depending on the settings you’ve 

selected for the Layer Type. 

 

ODB++ - Dialog Folder Customisation 

A new button has been added to the ODB++, Setup Folder. Use this to define the folder path when 

exporting non-compressed ODB++ files.  

Clicking this button will open the Setup Folder dialog from where you can choose various location 

settings for the output folder. 

 

Same folder as design file - This option saves the file into the same folder as the design file. 
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This folder below the design file - This option saves the file into a named folder below the design 

file. If the folder doesn't exist, the program will create it for you when the export is generated. 

Always to this folder - This option saves the file into a named folder, regardless of where the design 

file is. The Browse button allows you to locate the folder. 

File Name - Additionally, if you have the Compressed option ticked before entering the Setup 

Folder dialog, you will be given another option to specify the File Name of the compressed files. 

Variants – Warning when creating new PCB only Variants 

When attempting to create a new variant in a PCB design using the Design Technology, Variants 

option, you will be prompted with a warning describing the possible problems in doing this. This 

helps to prevent issues with back annotation failing due to the design having PCB only variants. 

 

New & Modified Library Content 

Changes have been made to the standard library installation shipped with Easy-PC Version 28: 

Two Star Point Component examples have been added, along with associated Schematic 

symbol and footprint. Examples are provided for a three-point star and 8-point star. 

 

A surface mount Testland example has been added to the library. The Component is 

available alone with the associated Schematic symbol and footprint. 

 

The PCB symbol will exist as part of the track (unless you specifically require it to be 

visible). We have provided a PCB symbol that is 10 Thou (0.250mm) but it can be edited to 

suit your requirements. 


